STM32-E407 development board
USER’S MANUAL

Revision K, September 2018
Designed by OLIMEX Ltd, 2012

All boards produced by Olimex LTD are ROHS compliant
DISCLAIMER

© 2018 Olimex Ltd. Olimex®, logo and combinations thereof, are registered trademarks of Olimex Ltd. Other product names may be trademarks of others and the rights belong to their respective owners.

The information in this document is provided in connection with Olimex products. No license, express or implied or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Olimex products.

This work is licensed under the Creative Commons Attribution-ShareAlike 3.0 Unported License. To view a copy of this license, visit http://www.creativecommons.org/licenses/by-sa/3.0/.

This hardware design by Olimex LTD is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License.

The software is released under GPL.

It is possible that the pictures in this manual differ from the latest revision of the board.

The product described in this document is subject to continuous development and improvements. All particulars of the product and its use contained in this document are given by OLIMEX in good faith. However all warranties implied or expressed including but not limited to implied warranties of merchantability or fitness for purpose are excluded. This document is intended only to assist the reader in the use of the product. OLIMEX Ltd. shall not be liable for any loss or damage arising from the use of any information in this document or any error or omission in such information or any incorrect use of the product.

This evaluation board/kit is intended for use for engineering development, demonstration, or evaluation purposes only and is not considered by OLIMEX to be a finished end-product fit for general consumer use. Persons handling the product must have electronics training and observe good engineering practice standards. As such, the goods being provided are not intended to be complete in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including product safety and environmental measures typically found in end products that incorporate such semiconductor components or circuit boards.

Olimex currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive. Olimex assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or services described herein.

# Table of Contents

**DISCLAIMER**

**CHAPTER 1 OVERVIEW**

1. Introduction to the chapter
1.1 Features
1.2 H407 or E407?
1.3 Target market and purpose of the board
1.4 Organization

**CHAPTER 2 SETTING UP THE STM32-E407 BOARD**

2. Introduction to the chapter
2.1 Electrostatic warning
2.2 Requirements
2.3 Powering the board
2.4 Prebuilt software

**CHAPTER 3 STM32-E407 BOARD DESCRIPTION**

3. Introduction to the chapter
3.1 Layout (top view)
3.2 Layout (bottom view)

**CHAPTER 4 THE STM32F407ZGT6 MICROCONTROLLER**

4. Introduction to the chapter
4.1 The STM32F407ZGT6 features

**CHAPTER 5 CONTROL CIRCUITY AND HARDWARE MODULES**

5. Introduction to the chapter
5.1 Reset
5.2 Clocks
5.3 Power supply circuit

**CHAPTER 6 CONNECTORS AND PINOUT**

6. Introduction to the chapter
6.1 JTAG/SWD debug
6.2 SD/MMC slot
6.3 UEXT module
6.4 USB_OTG1
6.5 USB_OTG2
6.6 LAN connector
6.7 Arduino/Maple platform
6.9 PWR Jack
6.10 Battery connector
## 6.11 BOOT connector

6.12 Jumper description

| 6.12.1 PWR_SEL | 20 |
| 6.12.2 B1_1/B1_0 and B0_1/B0_0 | 21 |
| 6.12.3 R-T | 21 |
| 6.12.4 3.3V_E | 21 |
| 6.12.5 AGND_E | 21 |
| 6.12.6 AREF_EN | 21 |
| 6.12.7 GPIO port jumpers | 22 |

6.13 Additional hardware components

| 7. HOW TO USE THE BOARD WITH ARDUINO IDE | 23 |

| 8. BLOCK DIAGRAM AND MEMORY | 24 |

8.1 Processor family block diagram

8.2 Physical memory map

| 9. SCHEMATICS | 26 |

9.1 Eagle schematic

9.2 Physical dimensions

| 10. REVISION HISTORY AND SUPPORT | 29 |

10.1 Document revision

10.2 Hardware revision

10.3 Useful web links and purchase codes

10.4 Product support
CHAPTER 1 OVERVIEW

1. Introduction to the chapter

Thank you for choosing the STM32-E407 single board computer from Olimex! This document provides a user’s guide for the Olimex STM32-E407 board. As an overview, this chapter gives the scope of this document and lists the board’s features. The differences between the members of the STM32-E407 and STM32-H407 boards are mentioned. The document’s organization is then detailed.

The STM32-E407 development board enables code development of applications running on the microcontroller STM32F407ZGT6, manufactured by STMicrocontrollers.

1.1 Features

- STM32F407ZGT6 Cortex-M4 210DMIPS, 1MB Flash, 196KB RAM, 3×12-bit 2.4 MSPS A/D, 2×12-bit D/A converters, USB OTG HS and USB OTG HS, Ethernet, 14 timers, 3 SPI, 3 I2C, Ethernet, 2 CANs, 3 12 bit ADCs, 2 12 bit DACs, 114 GPIOs, Camera interface
- JTAG connector with ARM 2x10 pin layout for programming/debugging
- UEXT connector
- 2 x USB-OTG
- SD-card
- Input DCDC power supply which allows operation from 6-16VDC source
- Power and User LEDs
- Reset and User buttons
- Arduino shield platform with provided headers
- 4 full 20-pin Ports with the external memory bus for add-on modules
- PCB: FR-4, 1.5 mm (0,062”), soldermask, silkscreen component print
- Dimensions: (4.00 x 3.40)” ~ (102 x 86)mm

1.2 H407 or E407?

The major difference between STM32-H407 and STM32-E407 is that the latter has built-in Ethernet (physical level transceiver Microchip's LAN8710A-EZC). STM32-E407 also features an extra USB-OTG and a number of SMD jumpers on the bottom which makes the control of the multiplexing pins easier. STM32-E407 has 2x USB-OTG both with a miniUSB interface. STM32-H407 has 1x USB-OTG and 1x USB-HOST with the On-The-Go interfaced by miniUSB and the HOST by USB type A connector.

If you need built-in Ethernet check the STM32-E407.
1.3 Target market and purpose of the board

STM32-E407 is a development board featuring a powerful ARM Cortex-M4F microcontroller with the most important peripherals, interfaces and connectors mounted and ready to use. The board can be powered by a number of different sources, can be programmed via two different interfaces, has a TON of GPIO pins available on a number of headers. The board's Arduino platform headers give another option for enthusiasts who wish to implement support for Arduino/Maple/Pinguino shields giving the board additional features altogether with the option to add Olimex extension modules on the OLIMEX UEXT.

The board can be programmed via Arduino IDE using USB_OTG1.

All of the above options make the board quite versatile and suitable for numerous tasks and situations. The power of ARM and the creativity of OLIMEX come at the best price and the well-known quality.

Every ARM enthusiast would see STM32-E407 as an interesting bargain and quite capable board for its low price.

1.4 Organization

Each section in this document covers a separate topic, organized as follow:

- Chapter 1 is an overview of the board usage and features
- Chapter 2 provides a guide for quickly setting up the board
- Chapter 3 contains the general board diagram and layout
- Chapter 4 describes the component that is the heart of the board: the STM32F207ZET6 microcontroller
- Chapter 5 is an explanation of the control circuitry associated with the microcontroller to reset. Also shows the clocks on the board
- Chapter 6 covers the connector pinout, peripherals and jumper description
- Chapter 7 gives advice on how to use the board with Arduino IDE
- Chapter 8 shows the memory map
- Chapter 9 provides the schematics
- Chapter 10 contains the revision history, useful links and support information
CHAPTER 2 SETTING UP THE STM32-E407 BOARD

2. Introduction to the chapter

This section helps you set up the STM32-E407 development board for the first time. Please consider first the electrostatic warning to avoid damaging the board, then discover the hardware and software required to operate the board.

The procedure to power up the board is given, and a description of the default board behavior is detailed.

2.1 Electrostatic warning

STM32-E407 is shipped in a protective anti-static package. The board must not be exposed to high electrostatic potentials. A grounding strap or similar protective device should be worn when handling the board. Avoid touching the component pins or any other metallic element.

2.2 Requirements

In order to set up the STM32-E407 optimally, the following items are required:

- JTAG or SWD interface programmer/debugger* – can power the board and gives the ability to program/debug the board – to choose the correct programmer be sure that you are aware what software tools you are going to use when programming STM32-E407, and that the programmer supports STM32F407 processor.

*The board can also be programmed with Arduino IDE via USB cable with mini USB connector using board’s USB-OTG1 connector;

Additional components can be acquired in order to increase the functionality of the board:

- External power supply
- USB type “A” to USB type “mini” cable is required for bootloader
- SD-card or extension UEXT modules are recommended but not required
- 3.7V Battery
- MOD-XXXX boards for additional features on the UEXT (RTC, TC, GSM, MP3, RS-485 among others) – note that you will have to implement the software setup between the boards
- Arduino/Maple/Pinguino shields – every shield is hardware compatible with H407 but will not work out-of-the-box, software implementation should be considered

Some of the suggested items can be purchased by Olimex, for instance:

ARM-USB-TINY-H – high-speed OpenOCD ARM JTAG debugger
ARM-USB-OCD-H – high-speed OpenOCD ARM JTAG debugger with buffer protection
USB-MINI-CABLE – USB mini to USB-A cable
BATTERY-LIPO1400MAH – lithium-polymer battery 1400mAh
USB-SERIAL-CABLE-F – easy way to connect the board to a computer terminal program using
the BOOT pins
SY0612E – power supply adapter 12V/0.5A for iMX233-STM32-E407

2.3 Powering the board

The board is powered in one of the following ways: 1) by PWR jack, 2) by JTAG/SWD programmer (3) by USB-OTG.

The PWR jack should be supplied from a 6V to 16V source with maximum current of 1A from the power jack. Without additional components and peripherals (no microSD card mounted, nothing connected to the USB, etc.) the typical consumption is 30mA @ 12V. For the European customers we sell an affordable power supply adapter 12V/0.5A – SY0612E.

It is worth mentioning that the board can NOT be powered by the battery connector. The battery connected keeps some of the processor's functions remain intact during power down but it provides insufficient power for the board to operate properly. For example the RTC doesn't lose the values when there is a battery connected.

2.4 Prebuilt software

Upon powering initially the board's red PWR LED and the green PWR LED should turn on. There are demo examples available for download at the product's page at the Olimex's web-site.
CHAPTER 3 STM32-E407 BOARD DESCRIPTION

3. Introduction to the chapter

Here you get acquainted with the main parts of the board. Note the names used on the board differ from the names used to describe them. For the actual names check the STM32-E407 board itself.

The board comes with a bag with 4 headers for the Arduino/Maple/Pinguino platform which were left unsoldered in case you don't wish to use those environments or you don't plan on using shields.

There is also a bag of 4 rubber pads which can be placed in the 4 corner holes of the board. That way the board will be safe from short-circuiting on the bottom if placed on low-resistance surface. The placement stability of the board will also increase.

3.1 Layout (top view)
3.2 Layout (bottom view)

On the bottom there are three tables printed – general jumper table, boot mode jumper table, power mode jumper table. The default positions of the tables are also shown.
CHAPTER 4 THE STM32F407ZGT6 MICROCONTROLLER

4. Introduction to the chapter

In this chapter is located the information about the heart of STM32-E407 – the Cortex-M4F microcontroller. The information is a modified version of the datasheet provided by its manufacturers from ST.

4.1 The STM32F407ZGT6 features

The processor's features according to the official datasheet:

- Core: ARM 32-bit Cortex™-M4 CPU with FPU, Adaptive real-time accelerator (ART Accelerator™) allowing 0-wait state execution from Flash memory, frequency up to 168 MHz, memory protection unit, 210 DMIPS/1.25 DMIPS/MHz (Dhrystone 2.1), and DSP instructions
- Memories
  - 1 Mbyte of Flash memory
  - 192+4 Kbytes of SRAM including 64-Kbyte of CCM (core coupled memory) data RAM
  - Flexible static memory controller supporting Compact Flash, SRAM, PSRAM, NOR and NAND memories
- LCD parallel interface, 8080/6800 modes
- Clock, reset and supply management
  - 1.8 V to 3.6 V application supply and I/Os
  - POR, PDR, PVD and BOR
  - 4-to-26 MHz crystal oscillator
  - Internal 16 MHz factory-trimmed RC (1% accuracy)
  - 32 kHz oscillator for RTC with calibration
  - Internal 32 kHz RC with calibration
  - Sleep, Stop and Standby modes
  - VBATsupply for RTC, 20×32 bit backup registers + optional 4 KB backup SRAM
- 3×12-bit, 2.4 MSPS A/D converters: 24 channels and 7.2 MSPS in triple interleaved mode
- 2×12-bit D/A converters
- General-purpose DMA: 16-stream DMA controller with FIFOs and burst support
- Up to 17 timers: up to twelve 16-bit and two 32-bit timers up to 168 MHz, each with up to 4 IC/OC/PWM or pulse counter and quadrature (incremental) encoder input
- Debug mode
  - Serial wire debug (SWD) & JTAG interfaces
  - Cortex-M4 Embedded Trace Macrocell™
- 114 I/O ports with interrupt capability
- Up to 15 communication interfaces
  - 3 × I2C interfaces (SMBus/PMBus)
  - 4 USARTs/2 UARTs (10.5 Mbit/s, ISO 7816 interface, LIN, IrDA, modem control)
  - 3 SPIs (37.5 Mbits/s), 2 with muxed full-duplex I2S to achieve audio class accuracy via internal audio PLL or external clock
  - 2 × CAN interfaces (2.0B Active)
  - SDIO interface
- Advanced connectivity
  - USB 2.0 full-speed device/host/OTG controller with on-chip PHY
  - USB 2.0 high-speed/full-speed device/host/OTG controller with dedicated DMA, on-chip full-speed PHY and ULPI
  - 10/100 Ethernet MAC with dedicated DMA: supports IEEE 1588v2 hardware, MII/RMII
  - 8- to 14-bit parallel camera interface up to 54 Mbytes/s
  - True random number generator
  - CRC calculation unit
  - 96-bit unique ID
  - RTC: subsecond accuracy, hardware calendar

For comprehensive information on the microcontroller visit the ST’s web page for a datasheet.

At the moment of writing the microcontroller datasheet has a document name DM00037051.pdf and can be found at the following link:

CHAPTER 5 CONTROL CIRCUITY AND HARDWARE MODULES

5. Introduction to the chapter

Here you can find information about reset circuit and quartz crystals locations, the power supply circuit is discussed.

5.1 Reset

STM32-E407's reset circuit includes R5 (10KΩ), R6 (1 KΩ), C19 (100nF) and a RESET button.

5.2 Clocks

There are two quartz crystals available on the board:

12 MHz quartz crystal Q1 is connected to pins 23 and 24 of the CORTEX-M4F processor.

Quartz crystal Q2 is a 32 768Hz RTC (real-time clock) and is connected to pins 8 and 9. The GND pin of the RTC quartz crystal is not soldered to allow easier change.

5.3 Power supply circuit

The power supply circuit of STM32-E407 allows flexible input supply from 6V to 16V direct current. This means a wide range of power supplies, adapters, converters are applicable. The maximum amperage the board can draw is 1A.

Note that the Li-Po battery connector cannot be used to fully power the board. Its function is to give an option to save internal data if the board needs to be relocated. It will keep the RTC alive, for instance.

If you have successfully powered the board the red PWR LED will turn on. Note that it is possible to have the PWR LED on even if there isn't enough power for proper operation of the board and all the peripherals currently connected.
CHAPTER 6 CONNECTORS AND PINOUT

6. Introduction to the chapter

In this chapter are presented the connectors that can be found on the board all together with their pinout and notes about them. Jumpers functions are described. Notes and info on specific peripherals are presented. Notes regarding the interfaces are given.

Note that slashed signals (xxxx/yyyy) in the tables below might mean either multiplexing between signals or port name correspondence on the processor.

6.1 JTAG/SWD debug

The board can be debugged from the 20-pin JTAG connector either by a JTAG or a SWD compatible debugger. Below is the table of the JTAG. This interface can be used with the Olimex's OpenOCD debuggers.

<table>
<thead>
<tr>
<th>JTAG/SWD interface</th>
<th>Pin #</th>
<th>Signal name</th>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>+3.3V</td>
<td>11</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>+3.3V</td>
<td>12</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>PB4/TRST</td>
<td>13</td>
<td>PB3/TDO</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>GND</td>
<td>14</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>PA15/TDI</td>
<td>15</td>
<td>PB4/TRST</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>GND</td>
<td>16</td>
<td>GND</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>PA13/TMS</td>
<td>17</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>GND</td>
<td>18</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>PA14/TCK</td>
<td>19</td>
<td>+5V_JTAG</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>GND</td>
<td>20</td>
<td>GND</td>
</tr>
</tbody>
</table>

6.2 SD/MMC slot

The microSD card slot is a standard 8pin connector.

We have tested a number of microSD cards on the STM32-E407 boards and all of them worked fine regardless manufacturer or capacity. However, keep in mind that some of the lower quality microSD cards might draw too much current from the slot which might cause power-state problems. If you suspect the microSD card is causing problems please try using another one of better quality for better results.
Notice that the pad numeration is written at the bottom of STM32-E407 under the microSD card connector.

When removing the card, please make sure that you release it from the connector by pushing and NOT by pulling the card directly (this can damage both the connector and the microSD card).

### 6.3 UEXT module

STM32-E407 board has UEXT connector and can interface Olimex's UEXT modules. For more information on UEXT please visit: [https://www.olimex.com/Products/Modules/UEXT/](https://www.olimex.com/Products/Modules/UEXT/)
6.4 USB_OTG1

USB On-The-Go, often abbreviated USB OTG, is a specification that allows USB devices such as digital audio players or mobile phones to act as a host allowing a USB flash drive, mouse, or keyboard to be attached and also connecting USB peripherals directly for communication purposes among them.

Note DFU bootloader uses the USB_OTG1 port, and a "USB micro-A" cable is required. This is the port used to program the board via Arduino IDE.

Note that the USB-OTG ESD protection ICs are not placed by default. However, there are pads provided for such protection.

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V_OTG1_PWR</td>
</tr>
<tr>
<td>2</td>
<td>USB_OTG1_D-</td>
</tr>
<tr>
<td>3</td>
<td>USB_OTG1_D+</td>
</tr>
<tr>
<td>4</td>
<td>PA10/OTG1_FS_ID</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
</tbody>
</table>

6.5 USB_OTG2

USB On-The-Go, often abbreviated USB OTG, is a specification that allows USB devices such as digital audio players or mobile phones to act as a host allowing a USB flash drive, mouse, or keyboard to be attached and also connecting USB peripherals directly for communication purposes among them.

Note that the USB-OTG ESD protection ICs are not placed by default. However, there are pads provided for such protection.

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V_OTG2_PWR</td>
</tr>
<tr>
<td>2</td>
<td>USB_OTG2_D-</td>
</tr>
<tr>
<td>3</td>
<td>USB_OTG2_D+</td>
</tr>
<tr>
<td>4</td>
<td>PB12/OTG2_HS_ID</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
</tbody>
</table>
6.6 LAN connector

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TD+</td>
</tr>
<tr>
<td>2</td>
<td>TD-</td>
</tr>
<tr>
<td>3</td>
<td>RD+</td>
</tr>
<tr>
<td>4</td>
<td>SHIELD</td>
</tr>
<tr>
<td>5</td>
<td>SHIELD</td>
</tr>
<tr>
<td>6</td>
<td>RD-</td>
</tr>
<tr>
<td>7</td>
<td>SHIELD</td>
</tr>
<tr>
<td>8</td>
<td>SHIELD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right</td>
<td>Green</td>
<td>Link status</td>
</tr>
<tr>
<td>Left</td>
<td>Yellow</td>
<td>Activity status</td>
</tr>
</tbody>
</table>

6.7 Arduino/Maple platform

The Arduino/Maple platform connectors (2x6 pin and 2x8 pin plastic headers) are not mounted but are included in the package. The reasons for not mounting the headers on the pin holes are two: first you might not need them if you do not wish to experiment with Arduino/Maple software; second there are two rows depending on the shield you might want to use the difference between the two rows is the distance between the two digital rows one is made according to the Arduino shield standard (e.g. you want to mount the row there if using Arduino certified shield), the other one is adjusted properly at 100mil step (e.g. you want to solder the digital pins here if using properly adjusted shields).

The pinhole names are printed near the actual pinhole on the top of the board.

<table>
<thead>
<tr>
<th>Arduino platform pinholes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CON1</strong></td>
</tr>
<tr>
<td>Pin</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>RST</td>
</tr>
<tr>
<td>3.3V</td>
</tr>
<tr>
<td>5V</td>
</tr>
<tr>
<td>GND</td>
</tr>
<tr>
<td>GND</td>
</tr>
<tr>
<td>VIN</td>
</tr>
</tbody>
</table>

The 4 20-pin connectors combine different processor ports and provide very nice GPIO option – you can use them with your breadboarding wires, you can mount headers, you can take measures, etc.

Note that all 4 headers come without connectors (unlike the UEXT or the JTAG) and connectors are not included in the package (unlike the Arduino platform). However they follow the standard 100mil step connectors – not hard to find and mount/solder if needed etc.

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal name</th>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+3.3V</td>
<td>11</td>
<td>PD8</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>12</td>
<td>PD9</td>
</tr>
<tr>
<td>3</td>
<td>PD0</td>
<td>13</td>
<td>PD10</td>
</tr>
<tr>
<td>4</td>
<td>PD1</td>
<td>14</td>
<td>PD11</td>
</tr>
<tr>
<td>5</td>
<td>PD2/SD_MMC*</td>
<td>15</td>
<td>PD12</td>
</tr>
<tr>
<td>6</td>
<td>PD3</td>
<td>16</td>
<td>PD13</td>
</tr>
<tr>
<td>7</td>
<td>PD4</td>
<td>17</td>
<td>PD14</td>
</tr>
<tr>
<td>8</td>
<td>PD5</td>
<td>18</td>
<td>PD15</td>
</tr>
<tr>
<td>9</td>
<td>PD6</td>
<td>19</td>
<td>+5V</td>
</tr>
<tr>
<td>10</td>
<td>PD7</td>
<td>20</td>
<td>GND</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>+3.3V</td>
<td>11</td>
<td>PE8</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>12</td>
<td>PE9</td>
</tr>
<tr>
<td>3</td>
<td>PE0</td>
<td>13</td>
<td>PE10</td>
</tr>
<tr>
<td>4</td>
<td>PE1</td>
<td>14</td>
<td>PE11</td>
</tr>
<tr>
<td>5</td>
<td>PE2/D2*</td>
<td>15</td>
<td>PE12</td>
</tr>
<tr>
<td>6</td>
<td>PE3</td>
<td>16</td>
<td>PE13</td>
</tr>
<tr>
<td>7</td>
<td>PE4/D3*</td>
<td>17</td>
<td>PE14</td>
</tr>
<tr>
<td>8</td>
<td>PE5/D4*</td>
<td>18</td>
<td>PE15</td>
</tr>
<tr>
<td>9</td>
<td>PE6/D5*</td>
<td>19</td>
<td>+5V</td>
</tr>
<tr>
<td>10</td>
<td>PE7</td>
<td>20</td>
<td>GND</td>
</tr>
<tr>
<td>Pin #</td>
<td>Signal name</td>
<td>Pin #</td>
<td>Signal name</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td>+3.3V</td>
<td>11</td>
<td>PF8/A3*</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>12</td>
<td>PF9/A4*</td>
</tr>
<tr>
<td>3</td>
<td>PF0</td>
<td>13</td>
<td>PF10/A5*</td>
</tr>
<tr>
<td>4</td>
<td>PF1</td>
<td>14</td>
<td>PF11/A6*</td>
</tr>
<tr>
<td>5</td>
<td>PF2</td>
<td>15</td>
<td>PF12</td>
</tr>
<tr>
<td>6</td>
<td>PF3</td>
<td>16</td>
<td>PF13</td>
</tr>
<tr>
<td>7</td>
<td>PF4</td>
<td>17</td>
<td>PF14</td>
</tr>
<tr>
<td>8</td>
<td>PF5</td>
<td>18</td>
<td>PF15</td>
</tr>
<tr>
<td>9</td>
<td>PF6/A1*</td>
<td>19</td>
<td>+5V</td>
</tr>
<tr>
<td>10</td>
<td>PF7/A2*</td>
<td>20</td>
<td>GND</td>
</tr>
</tbody>
</table>

Note that all signals marked with asterisk (*) are multiplexed with signals of the Arduino platform. Those signals can be controlled by the provided jumpers. However, the jumpers are soldered by default which enables them on the GPIO connector and the Arduino shield at the same time.

PG11, PG13, PG14, PG16 and PG17 are multiplexed with the UEXT and the Ethernet. Their connection is not controlled by jumpers.

### 6.9 PWR Jack

The power jack used is the typical one used by Olimex in most of our products – the DC barrel jack has 2.0mm inner pin and 6.3mm hole. More information about the exact component might be found here: [https://www.olimex.com/wiki/PWRJACK](https://www.olimex.com/wiki/PWRJACK).

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power input</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
</tr>
</tbody>
</table>

More info about the power supply can be found in chapters 2 and 5 of this manual.
### 6.10 Battery connector

When using the battery connector keep in mind that it is an energy solution that wouldn't be able to power the board and all the peripherals!

It help keeping information in the processor if you need to transport the board from one power supply to other.

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBAT</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
</tr>
</tbody>
</table>

The pin names are also written on the bottom of the board in the base of the connector.

### 6.11 BOOT pads

The best use for the GND, RX3, TX3 pins from the BOOT connector would be getting the output of the available demo program on a computer terminal via USB-Serial-CABLE-M (https://www.olimex.com/Products/Components/Cables/USB-Serial-Cable/USB-Serial-Cable-M/)

BOOT are 3 pinholes set on USART3 and are named on the bottom – GND, RX3, TX3 and notice there are two vias near them which are actually VCC and can be used if connecting BOOT. More information about booting over UART can be found in the processor's datasheet.

### 6.12 Jumper description

Please note some of the jumpers on the board are SMD type. If you feel insecure in your soldering/cutting technique it is better not to try adjusting SMD jumpers.

Also if you feel incapable of removing the PTH jumper with hand better use tweezers. We do.

#### 6.12.1 PWR_SEL

PWR_SEL is important PTH jumper allowing easy switching of input current. You can use tweezers to reach it. If you are powering the board via the PWR_JACK set it to position 1-2 (default → to the near edge of the board).

If powering from the JTAG/SWD set the jumper in position 3-4.

If powering from the USB-OTG2 set it in 5-6 position (near battery connector).

If powering from the USB-OTG1 set it in 7-8 position (near LAN connector).

The default position is 1-2.
6.12.2 B1_1/B1_0 and B0_1/B0_0

These two PTH jumpers set where the board should boot from. B1_1/B1_0 and B0_1/B0_0 are PTH jumpers and their position can be changed relatively easy. The board can try to boot from three places and that depends on the position of the B1_1/B1_0 and B0_1/B0_0 – User Flash Memory, System Memory or the Embedded SRAM.

Notice that these two jumpers must be moved together – they are responsible for the boot mode if bootloader is present.

The DFU bootloader is found on USB_OTG1.

If B0_0 is closed the board will try to boot from User Flash Memory.

If B0_1 is closed there are two variants depending on the state of B1_1/B1_0 jumper – if B0_1 is closed and B1_0 is closed the board will try to boot from System Memory. If B0_1 is closed and B1_1 is closed bootloader must be located in the Embedded SRAM.

The default positions are B0_0 and B1_0 (Boot from User Flash Memory).

6.12.3 R-T

This is SMD type jumper.

If you close/solder this jumper RST and TRST at the JTAG will be connected.

The default position is open/unsoldered.

6.12.4 3.3V_E

This is SMD type jumper.

Board digital power will be disabled if open/unsoldered

The default position is closed.

6.12.5 AGND_E

This is SMD type jumper.

If open/unsoldered will disable analog ground.

The default position is closed.

6.12.6 AREF_EN

This is SMD type jumper. If open/unsoldered will disable ADC reference.

The default position is closed.
6.12.7 GPIO port jumpers

These are SMD type of jumpers located on the bottom of the board. They are located on the bottom of the board. We provided those in case you want to separate the multiplexing between the Arduino shield and the GPIO connectors. Check chapter 6.8 for more information on the multiplexing. Generally if you wish to avoid the multiplexing you have to cut the wire between the pads.

6.13 Additional hardware components

The components below are mounted on STM32-E407 but are not discussed above. They are listed here for completeness:

Reset button – used for hardware reset of the board

WKUP button – can be used as user button

User LED + Power LED
CHAPTER 7 HOW TO USE THE BOARD WITH ARDUINO IDE

In order to program the board with Arduino IDE you would need a USB cable with mini USB connector. Note that you would also need to enter bootloader mode by manipulating the B0_1/B0_0 and B1_1/B1_0 jumpers.

1) Download and install latest Arduino IDE.

2) Go to: File -> Preferences -> Additional Boards Manager URLs:

https://raw.githubusercontent.com/OLIMEX/Arduino_configurations/master/STM/package_olimex_stm_index.json

3) Tools -> Board -> Boards manager…

4) Select "Olimex STM32 boards" -> Install (if Arduino SAM Boards package is not installed it will download the compiler so it will take some time)

5) Select: Tools -> Board -> STM32-E407

6) Select: File -> Examples -> STM32-E407 -> <choose one of the examples>

7) Connect the USB cable to USB_OTG1 port of STM32-E407.

8) Set the board in DFU bootloader mode (set jumper B0_1/B0_0 -> B0_1; and B1_1/B1_0 -> B1_0 and reset the board)

   8.1) If the device is not recognized install driver (WinUSB) using Zadig installer (download link: http://zadig.akeo.ie/)

9) Compile and upload the sketch

10) Run the board in the default boot from flash mode (jumpers B0_1/B0_0 -> B0_0; B1_1/B1_0 -> B1_0 and reset the board)

11) The uploaded sketch would be executed.

You need to set the jumpers in DFU bootloader mode every time that you want to upload. Then to execute the code, revert the jumpers back to boot from flash mode and reset.
CHAPTER 8 BLOCK DIAGRAM AND MEMORY

8. Introduction to the chapter

On the next page you can find a memory map for this family of processors. It is strongly recommended to refer to the original datasheet released by STMicroelectronics for one of higher quality.

8.1 Processor family block diagram

1. The timers connected to APB2 are clocked from TIMxCLK up to 168 MHz, while the timers connected to APB1 are clocked
8.2 Physical memory map

The diagram illustrates the physical memory map of the STM32-E407 microcontroller, showing various memory blocks and their addresses. The diagram includes:

- **512-Mbyte block 7**: Cortex-M4's internal peripherals, starting at 0xFFFF FFFF.
- **512-Mbyte block 6**: Not used, starting at 0xE000 0000.
- **512-Mbyte block 5**: FSMC registers, starting at 0xC000 0000.
- **512-Mbyte block 4**: FSMC bank 3 & bank4, starting at 0xA000 0000.
- **512-Mbyte block 3**: FSMC bank 1 & bank2, starting at 0x8000 0000.
- **512-Mbyte block 2**: Peripherals, starting at 0x6000 0000.
- **512-Mbyte block 1**: SRAM, starting at 0x4000 0000.
- **512-Mbyte block 0**: Code, starting at 0x0000 0000.

The diagram also highlights several memory segments for specific purposes:

- **SRAM**: (16 KB aliased by bit-banding), starting at 0x2001 0000 - 0x2001 FFFF.
- **SRAM** (112 KB aliased by bit-banding), starting at 0x2000 0000 - 0x2001 0000.
- **Option Bytes**.
- **System memory**.
- **CM CCM data RAM** (64 KB data SRAM).
- **Flash**.

The memory map also indicates reserved addresses for various registers and components:

- **AHB1**: 0xA000 0000 - 0xBFFFF FFFF.
- **AHB2**: 0x5000 0000 - 0x5000 07FF.
- **AHB2**: 0x5000 0800 - 0x5000 0FFF.
- **AHB2**: 0x5000 0000 - 0x5000 07FF.

The diagram also shows memory segments assigned to specific components:

- **Reset clock controller (RCC)**: 0x4002 2000 - 0x4002 2FFF.
- **CRC**: 0x4002 2400 - 0x4002 2FFF.
- **AHB1**: 0x4002 3000 - 0x4002 3FFF.
- **AHB2**: 0x4002 4000 - 0x4002 4FFF.
- **APB1**: 0x4001 0000 - 0x4001 0FFF.
- **APB2**: 0x4001 1000 - 0x4001 1FFF.
- **EXT1**: 0x4001 3000 - 0x4001 3FFF.
- **SYS CFG**: 0x4001 3800 - 0x4001 3FFF.
- **Reserved**: 0x4001 3400 - 0x4001 3FFF.

The memory map is designed to provide a clear understanding of the allocation and accessibility of memory resources in the STM32-E407 microcontroller.
CHAPTER 9 SCHEMATICS

9. Introduction to the chapter

In this chapter are located the schematics describing logically and physically STM32-E407.

9.1 Eagle schematic

STM32-E407 schematic is visible for reference here. You can also find them on the web page for STM32-E407 at our site: https://www.olimex.com/Products/ARM/ST/STM32-E407/. They are located in HARDWARE section.

The EAGLE schematic is situated on the next page for quicker reference.
9.2 Physical dimensions

Note that all dimensions are in millimeters.

The three highest elements on the board in order from the tallest to the shortest are: capacitor C50 – 17.2mm (0.677”) over the pcb; LAN connector – 13.6mm (0.535”); capacitors C42 and C48 – 11.5mm (0.453”).

Note that the above measures does not include the PCB.
CHAPTER 10 REVISION HISTORY AND SUPPORT

10. Introduction to the chapter

In this chapter you will find the current and the previous version of the document you are reading. Also the web-page for your device is listed. Be sure to check it after a purchase for the latest available updates and examples.

10.1 Document revision

<table>
<thead>
<tr>
<th>Revision</th>
<th>Changes</th>
<th>Modified page#</th>
</tr>
</thead>
<tbody>
<tr>
<td>A, 25.07.12</td>
<td>Initial release</td>
<td>All</td>
</tr>
<tr>
<td>B, 02.08.12</td>
<td>Added info about serial monitor via USB-SERIAL-CABLE</td>
<td>8, 21</td>
</tr>
<tr>
<td>C, 20.03.13</td>
<td>Added info about the bootloader, fixed links</td>
<td>17, 32</td>
</tr>
<tr>
<td>D, 10.07.13</td>
<td>Added revision E schematic, adjusted disclaimer</td>
<td>2, 29</td>
</tr>
<tr>
<td>E, 02.12.13</td>
<td>Fixed an error in the table of Arduino platform headers, updated customer support page</td>
<td>19, 32</td>
</tr>
<tr>
<td>F, 01.07.15</td>
<td>Added more information about two specifics – the lack of soldering on the GND line of the quartz crystal and the lack of mini USB protection; improved the top picture of the board; improved information about the power jack; uploaded a new schematic; fixed links</td>
<td>9, 13, 16, 19, 26</td>
</tr>
<tr>
<td>G, 26.05.16</td>
<td>Added information on how to connect the board to Arduino IDE; clarified information about the UEXT connector</td>
<td>15, 23</td>
</tr>
<tr>
<td>H, 21.12.16</td>
<td>Updated json link</td>
<td>23</td>
</tr>
<tr>
<td>I, 16.06.16</td>
<td>Fixed wrong Ethernet connector pinout</td>
<td>17</td>
</tr>
</tbody>
</table>
10.2 Hardware revision

<table>
<thead>
<tr>
<th>Revision</th>
<th>Revision notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1</td>
<td>Initial release</td>
</tr>
<tr>
<td>C</td>
<td>FET1 removed; the TVS symbol fixed (both near the input power). It is unidirectional and helps with the data protection.</td>
</tr>
<tr>
<td>D</td>
<td>The PHY was changed and all libraries were updated.</td>
</tr>
</tbody>
</table>
| E        | 1. R5 was changed from 10k/1% to 10k;  
2. R70(0R) was changed to 10k and renamed to R13, added was C26=10uF/6.3V and RST connection was removed from the PHY!;  
3. SD/MMC package was changed to the newer version (much more universal);  
4. WKUP and RESET packages were changed to WS-TAKT_6X3.5_SMD_NOCREAM;  
5. Everything is renumbered, so there are no missing numbers.  
6. C4 was changed from 100nF to 10uF/6.3V;  
7. Added is R54 = 47k pull-up to Rx line; |
| F        | 1. Fixed JMP names – B0.1/B0.1 and B1.1/B1.1 to B0.1/B0.0 and B1.1/B1.0  
2. CD1 with new package 5032 50 MHZ 25ppm 3V.  
3. SD card connector new type TFC-WPAPR-08.  
4. Changed the bottom double USB key with two SY6280.  
5. Changed a lot of electrolyte capacitors with 47uF/6.3V  
6. Replaced 200mA ferrite beads with 2A ones; L2 also changed to FB0805/600R/2A  
7. MP1482DS dc-dc replaced with MP1584EN(SOIC8E).  
8. Added LAN shielding capacitor.  
9. R31 and R21 changed to 1.1K (up from 549R).  
10. R50 and R26 changed to 2k (up from 1k) |
10.3 Useful web links and purchase codes

The web page you can visit for more info on your device is https://www.olimex.com/Products/ARM/ST/STM32-E407/.

You can get the latest updates on the software at: https://github.com/OLIMEX/STM32F4.

ORDER CODES:

**STM32-E407** – the version of the board discussed in this document

**STM32-H407** – the smaller version of the board without Ethernet

**ARM-USB-TINY-H** – OpenOCD compatible high-speed debugger/programmer with JTAG interface

**ARM-USB-OCD-H** – OpenOCD compatible debugger/programmer with JTAG interface, protection buffers and better power supply circuit

**SY0612E** – power supply adapter 12V/0.5A for STM32-E407 – 220V (European compatibility)

How to order?

You can order directly from our web-shop or from any of our distributors.

10.4 Product support

For product support, hardware information and error reports mail to: support@olimex.com. All document or hardware feedback is welcome. Note that we are primarily a hardware company and our software support is limited. Please consider reading the paragraph below about the warranty of Olimex products.

All goods are checked before they are sent out. In the unlikely event that goods are faulty, they must be returned, to OLIMEX at the address listed on your order invoice.

OLIMEX will not accept goods that have clearly been used more than the amount needed to evaluate their functionality.

If the goods are found to be in working condition, and the lack of functionality is a result of lack of knowledge on the customers part, no refund will be made, but the goods will be returned to the user at their expense.

All returns must be authorized by an RMA Number. Email support@olimex.com for authorization number before shipping back any merchandise. Please include your name, phone number and order number in your email request.

Returns for any unaffected development board, programmer, tools, and cables permitted within 7 days from the date of receipt of merchandise. After such time, all sales are considered final.

Returns of incorrect ordered items are allowed subject to a 10% restocking fee. What is unaffected? If you hooked it to power, you affected it. To be clear, this includes items that have been soldered to, or have had their firmware changed. Because of the nature of the products we deal with (prototyping electronic tools) we cannot allow returns of items that have been programmed, powered up, or otherwise changed post shipment from our warehouse.

All returned merchandise must be in its original mint and clean condition. Returns on damaged, scratched, programmed, burnt, or otherwise ‘played with’ merchandise will not be accepted.

All returns must include all the factory accessories which come with the item. This includes any In-Circuit-Serial-Programming cables, anti-static packing, boxes, etc.

With your return, enclose your PO#. Also include a brief letter of explanation of why the merchandise is being returned and state your request for either a refund or an exchange. Include the authorization number on this letter, and on the outside of the shipping box.

Please note: It is your responsibility to ensure that returned goods reach us. Please use a reliable form of shipping. If we do not receive your package we will not be held liable.

Shipping and handling charges are not refundable. We are not responsible for any shipping charges of merchandise being returned to us or returning working items to you.

The full text might be found at https://www.olimex.com/wiki/GTC#Warranty for future reference.